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Introduction

Visual Basic implements graphical user interface that allows the use of graphics for
different applications. It provides visual interactive windows with user, like Dialogue box
for (color, font ...), Input box, and Output box. Also it is able to create menu to simplify

user application.

To run this program on user computer: Start>programs>Microsoft Visual Studio
6.0>Microsoft Visual Basic 6.0.
It will appear on the computer screen as in the following picture.
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1.2-The Importance of Visual Basic Program

Languages like Basic and Pascal depend on variables and procedures to build the
applications .This is why it is called procedural languages. The new approach is called object
programming for visual programs like Visual Basic and Visual C++ and others. In this
programming approach everything (form, command buttons, controls) is an object.

The reasons for of implementing Visual Basic program are listed as follows:

1- It uses integrated development environment (IDE) which is easier for the user to

minimize code writing.

2- All visual programs follow the same concepts, therefore the user will become more

familiar with visual approach for other visual languages.

3- It provides Input box and Output box as an interactive windows with user.




4- It is able to connect to Internet, and to call Explorer.
1.3- Elements of the Integrated Development Environment (IDE)

Figure below shows The IDE after Standard EXE is selected. The top of the IDE window (the
title bar) displays “Project1-Microsoft Visual Basic [design]”.The environment consists of
various windows when Visual Basic is started (by default):

a- IMlenu Bar: It contains a standard command lIKe: File, EdIt, VIew, WINndow, Help menus,
and specific command such as: Project, Format, or Debug menus.

b- Toolbar: it contains the most commonly used commands (button), if clicked an action
represented by that button is carried out.

c- ToolBox: it contains a collection of tools that are needed for project design.

d- form Designer: it is a window for each form to customize the designed interface of the
application. Using the form designer, the user can add controls, graphics, and text to create
the desired form appearance.

e- Properties Window: it is a List of properties settings for a selected form or a control.
These properties are characteristics (such as size, visible, or color) of the selected object it
provides an easy way to set properties.



f- Project Explorer Window: it is a list of the forms and modules for the current projects. It is
a hierarchical tree- branch structure, where the project at top of tree and other parts like
forms ,modules) descend from this tree.

g- Form Layout Window: The Form Layout window is a small screen. Which is used to
reposition the form of the application so that it appears in proper place when project is run.

h- Code Editor Window: Code Editor Window is used to write a VB code for an application.
For each form there is a separate code editor window. It is displayed when user clicks on
form or object in form.
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To Create an Application
The title of program includes the name of project, and when the user first starts the
program it takes a defaulted value (project).It also include resize icons. The following steps
are required to create an application in Visual Basic 6.0:
1- Select type of project New or Exciting. A form automatically appears in the form
design .The basis for any application's interface is the form that user should create. User
can add other forms to the project (to add another form select project menu>add form).
2. To add objects (controls) to the form use the ToolBox.
3. Set the properties for the objects through properties window.
4. Write code. The Visual Basic Code consists of statements, and declarations.
The code for an application can be written on the Code Editor window.
In this window user can view and edit quickly any of the code.
5. Run the Application. To run the application, click the Start button on the toolbar, or
press F5.



6. Stop. To stop running the application and return to visual basic program on stop
button in tool bar.

7. Check if there is an error, return to step 3 ,otherwise continue.

8. Save project.

9. Exit.

Project

Project is a program designed to user application that may be simple (like calculator
program) or complex (like word program). Visual basic program can create many types of
projects. The most important or usual project is the standard project (for window
applications) and the DHTML project (for internet).

Working with Standard Projects:

The following working steps (create, save, add, open and delete) could be done:

a) To create project:

When program starts, project box appears-select Standard EXE > Project window
appears.

OR: File> New project> Box (select Standard EXE)> Project window appears
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b) To add project: Any number can be added.
Project icon> Select Standard EXE> Project window appears.

Note: Usually first project runs first, but user can change that by:
Selecting project from project window > mouse list > Set as startup.

¢) To open an existing project:
It is previously designed and saved on disc in a folder.
File> Open project> Box (select existing and look for the project) > Project window



d) To delete a project:
Select project in Project window > Mouse list > Remove project.

e) To save project:
The visual basic can save the project on disc in two ways, as an executable type or a non-
executable type.

A- for project in non execution stage:

There are many types of files summarized as follows:

1- Project file: it consists of all files which are related to specific project, also some other
information with it. This could be saved with extension

(\VBP)

2- The form Files: this contains form description and any Object or

program related to it .This is saved with extension (.frm).

To save project for first time:

File>Save project (group) as>Box (project name)> forms saved then projects group saved.
To resave project: to save previously saved project in same place

File>save project (group)

Note: If a form is modified it should be saved. To save a form:
Select a form from Project window>File>Save project form1 as > Save box (select form
name). OR: File>Save project forml.

B- project for execution: This is the final stage so that it could be opened and run by
Windows and no need for Visual Basic program. File> Make project.exe.



Item Action steps Remarks
Create |New File=New project The user can open any number of
project projects.
Exist File=Open project Project was already designed and
saved.
Recent File=Open project Project was recently designed and
saved.
Save project File=Save project group |Visual Basic can deal with it (open
as and modify).
File=Make projectl.exe |For execution by window.
Delete project File= Remove project Select project before remove.
Forms

1) Introduction to form

The form is the most important visible object, without it no control can be displayed. It is
a window that can be designed and modified to fit user applications. In the standard
project the form Designer creates and modifies visual forms When user starts visual Basic
program a form is automatically displayed in Designer window. The designer can add any
number of forms to the project of his application by pressing: add form from project menu.

There are two modes: design mode and running mode. User can interchange between
them, by pressing on start icon or stop icon on tool bar.

The forms also have properties and events.



2) Form properties

Properties list has a predefined value (numeric or string) and could be changed, some
properties could be rewritten like caption, and some could be selected from option list by
pressing on down arrow on the side.

Others could be rewritten or by browsing the computer files when the user clicks on
the dotted button on the right side a dialogue box appears. The browsing button appears
when the user clicks inside the box.

The most important properties of the form are listed in the following table:




3) Code form
The code is written in code Form and it will be edited quickly by code editor . The
codes are of two categories:
1- Declaration is written before any procedure in the code

2- Statements. The user selects the required event then code statements are written
inside these event procedures.
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4) Events:

Events are like electrical switches. The electrical switches are of many types, so are the
events.
The forms and controls support events (generation, interaction with mouse and
keyboard). The most important events for the form are described in the following table.

Event Action taken when
Click Single click on object.
DbClick Double click on object.
load Loading the object

Examples:
1- Design a form such that: in event load, when project runs, the form backcolor
property changed (chose any color).
sol:
code:
Private Sub Form_Load()
Form1.BackColor = QBColor(12)
End Sub



Toolbox Controls: Contains a collection of tools that are needed for project
design as shown in Fig. below. To show the toolbox press View> toolbox icon.
The user can place the tool on form, and then work with the tool. To place the
tool on form: click on tool>draw tool to form > the tool appears on form or
double click on tool then the tool appears on form. Table (1) summarizes the
toolbox controls.

Table (1): Toolbox controls suminary.

Control Description

Pointer Used to interact with controls on the form(resize them. move them. ete.). The pointer is not a
confrol

PictureBox A control that display images or print the resulf.

Label A control that displays uneditable text to the user.

TextBox A control for accepting user input. Textbox can also display text.

Frame A control for grouping other controls.

CommandButton | A control that represents a button. The user presses or clicks to initiate an action.

CheckBox A control that provides the user with a toggle choice (checked or unchecked)

OptionButton Option buttons are used in groups where only one at a time can be true,

ListBox A control that provides a list of items.

ComboBox A control that provides a short list of items.

HserollBar A horizontal scrollbar.

VserollBar A vertical scrollbar.

Shape A control for drawing circles, rectangles, squares or ellipse

Line A control for drawing line.

DrivelistBox A control accessing the system disk drivers.

DirlistBox A control accessing directories on a system

Filelistbox A control accessing file in a directory

Image A control for displaying images. The images confrol does not provide as many capabilities as a
picturebox.

OLE A control for interacting with other window applications.

Timer A confrol that performs a task at programmer specified intervals. A timer is not visible to the
user.




Tool Box and Form

The user can place the tool on form and then work with the tool. To place the tool on
form:

Click on tool >Draw tool to Form> the tool appears on Form.

Or: double click on it.

Notes:

a) Each tool has a property window .To see this window: Click on tool on form>
Property window appears.

b) Property can be changed manually or by code and the effect of code appears in the
run time (when user runs project).

c) To put code for tool action:

Double click on tool > code sheet of the Form appears (with code of corresponding
tool is written) > User write the desired code inside tool event, or outside in Form

event.

Label:
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Property v . .
pert Objective Code Stage of Changing
name
Caption | String appear on label labely, .caption= "any name" Design and run
Autosize |To resize tool to fit text labely, .autosize=true or false  |Design and run

Type: label. FontName = "arial”

Backeolor |Background color for label  |labely, Backcolor=Qbcolor(no.) |[Design and run
Forecolor |Color of text written on label |labely, .forecolor=Qbceolor(no.) [Design and run
Font Font style. type and size Size: labely, .fontsize= no. Design and run
" italic
Style: font | bold
_ama’m‘fne

visible  |The label appear  or|Labely,.visible= true or false Design and run
disappear
Enabled |The label enable or disable. |label 5. Enabled =true or false  |Design and run




Note: The available color numbers that used with QBcolor is the integers 0 to 15

only

Example: Design a form contains label 4wkl a gla!

Sol: the properties are:
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Textbox

The textbox is a box for entering and displaying text (characters or values) in user
project. This tool is used frequently in most of the application. The textbox has
property window, with no caption, but with space for text. The most important

property of this tool is the text content which is described in the following:

Property | opiective Code Stage o
name Changing
Text String appear on textbox feXt g0 . teXt = "any name" Design and run
multiline To enter more than one line true or false Design
Backcolor  |Background color for textbox. |text ,,.Backcolor=Qbcolor(no.) |Design and run
Forecolor Color of text written on textbox. |text 4, .forecolor=Qbcolor(no.)  |Design and run
Font Font style, type and size. Size: text g .fontsize=no. Design and run
italic
SIS ) bold
underline
Type: label.FontName = "aral"
visible The textbox appear or disappear |text 4,.visible= true or false Design and run
Enabled The textbox enable or disable. |text ,,. Enabled =true or false  |Design and run
passwordchar |[A row of symbols appear|Texty, passwordchar=(symbol) |Design and run
instead of letters
Setfocus Put the focus on the specified|Texty,.setfocus Run
textbox




Change text manually: change text property from property window, click
inside textbox and add text.
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Change text by code:
1- Text1.text=""
2- Text1.text="_="
3-Textl.text=text2.text
4- Text1.text=labell.caption
5- Text1.text = inputbox (" (" o=

Example: Design a form to enter username and password such that the title of the
form is VB.

Sol: design stage

Forml
caption | VB
Textl
text |
Text2
Text |
Labell
caption | username
Label2
caption | password

Example: Design a form with one textbox, set the text properties so that this massage
when project runs (welcome to visual basic world).

Sol: There are two methods:
First method: changing property by code:



Private Sub Form_Load()
Text1.Text = "welcome to visual basic world"
End Sub

Second method: by properties window

Textl

text Welcome to visual basic world

Command button

It acts as a switch. To deal with tool property> click on command button> property
window appear> change setting of any desired property. Usually change set its
caption property to a suitable string.

To make the button functional, the user should add some code. To do this: click on
command tool> code form appears with click event procedure. Write code in this
event or other events like press key event.



The most familiar properties that are needed for the command button are stated in the table

below.
LSy Objective Code Stage of Changing
name
Caption  |String appear on command |command,, .caption="any name" |Design and run
style Determine the style of|l-graphical Design
command 0-standard
Backcolor |Background color for |command,, .Backcolor=Qbcolor( | Design and run
command no.)
Forecolor |Color of text written on|command,,.forecolor=Qbcolor( |Design and run
command no.)
Font Font style. type and size Size: command,, .fontsize=mno. |Design and run
italic
S‘L'}Tlﬁ‘: fonr bold
underline
Type: command,, FontName =
"arial"
visible The command appear or|command,,.visible= true or false |Design and run
disappear
Enabled |The command enable or|command,,. Enabled =true or|Design and run
disable. false
Private Sub Command1_Click()
Labell.Caption = "Ahmad"
End Sub
Labell

Command]




Example: Design a form to appear your name and department in textbox, when click on
command button "name" and "department" respectively so that you can clear these
information's when click on command "clear" and stop project when click on command

"exit".

Textl

Command1

Command3

“- ——  Command?2

<4+——— Command4

text |

Command]1

caption | name

Command?2

caption | department

Command3

caption | Clear

Command4

caption | exit

Private Sub Command1_Click()
Text1l.text="Muna"

End Sub

Private Sub Command2_Click()
Text1.text="Science"

End Sub

Private Sub Command3_Click()
Text1l.text=""

End Sub

Private Sub Command4_Click()
end

End Sub



Example: Design a form contains two textbox so that when click on command button
"copy" the text copied from first textbox to the second textbox but in size (28).
Sol:

Private Sub Command1 Click() Textl
Text2.Text = Textl. Text text ‘
Text2.FontSize = 28 Text?
End Sub Text ‘-

At run stage this window appear captiocl;mmm\ﬂf;pv

If the user enter by example the text (ABC) in first textbox and click on command (copy)
the same text appear on the second textbox but in size 28.

. Forml =0l =]

ABC

ABC




Option button: Used only as a group of buttons. When the user selects one of them
the others are deselected automatically.

All other properties of this control are similar to those in form and command button
where they are fully discussed which are caption, font, enabled, backcolor and visible
beside an important property which is value that takes true or false and it used with
if statement. The option button usually takes click event.

Example: Design a form with three option buttons " red ", " green " and " blue " such
that when we click on options the color of the form colored by red, green and blue
respectively.

Private Sub Option1_Click()
Form1.BackColor = vbGreen
End Sub

optionl:caption | green
option2: caption | blue
option3: caption | red

Private Sub Option2_Click()
Form1.BackColor = vbBlue
End Sub

Private Sub Option3_Click()
Form1.BackColor = vbRed
End Sub




Check box:
Any number of check boxes can be used on a form. They work independently.

Its Property value could be changed in design stage manually, or in running stage by
code.

Private Sub Check1_Click()
Text1l.FontBold = Check1.Value

End Sub

Private Sub Check?2_Click()
Text1.Fontltalic = Check2.Value

End Sub

Private Sub Check3_Click()
Text1l.FontUnderline = Check3.Value
End Sub

Run stage:

I Form1 =l . Form1 =10l x| I Form1 -10| x|
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Timer
Timer returns the time in millisecond. It may be used to measure execution time of
code (program efficiency).

Property name Objective and code

interval To repeat the code according to event. It takes an
integer values (0-65535) and measured in millisecond

enabled tfimer,, . Enabled =true or false

Ex: design electronic clock to display the time in seconds.
sol:

Timerl S S

mterval 1000 Dol i

Labell CIlliiiiiiiiiiiiiiiiiiiiiiiod
Caption

_|of x|

052320 »

Example: Design a form to display "applied science" such that when click on
command button "start" the color of "applied science" changed randomly every




Private Sub Command1_Click()
Timer1l.Enabled = True

End Sub

Private Sub Timer1_Timer()

t=Rnd * 15

Labell.ForeColor = QBColor(CInt(t))
End Sub

Run stage:
When click on command button ' the color of the font will be change every second

randomly in integer no. (0-15). :
'~ Formi TR

........................

Note: the function (Cint) used to convert to integer no.
And (Rnd) used to generate a random no. in a range (0-1)

Input - output boxes

There are two types of dialog boxes which are inputbox and messagebox. The first is
used to input variable and the second to output variable or message. Both needs code
and appear at run time.

a) Inputbox
Inputbox used to input value or characters for one variable from keyboard at running

stage.
This box needs a code in code sheet and could be written in any event or command

X=inputbox(" prompt or remark"”, "title")

prormpk 0k

Cancel

If




Example: enter value of x using inputbox

Sol:

calculation x|

enter value of = 0K

Cancel

I

Private Sub Form_Load()
X=Inputbox("enter value of x", "calculation")
End Sub

Message box
[t is used to output a message to the user (at running stage) the code needed could be

written in code sheet and in any event or command.

The available icons for message box

The available commands for message box



For example if we write the following statement then a message box will be appear as
shown below

MsgBox "please close your program”, 16, "Error”

or

MsgBox "please close your program”, vbcritical, "Error”

Eror =

0 pleaze close vour program

Example: show what appear after running the following statement

MsgBox "are you sure you want to delete this file", 32 + 4, "delete”

or

MsgBox "are you sure you want to delete this file",vbQuestion+vbYesNo,"delete"
Sol: : -

® are you zure you want to delete thizs file

Mo |

Example: write a program to move the text (excellent) from textbox to message box
and change the color of the text after click on command button (display).

Sol:

Textl: text="excellent"

Command]l: caption=""y=_=

Private Sub Command1_Click()
MsgBox (Text1l.Text)
Text1.BackColor = QBColor(9)
Textl.Text=""



End Sub

Or we can write the following code:
Private Sub Command1_Click()
X=Text1.Text

MsgBox (X)

Text1.BackColor = QBColor(9)
Textl.Text=""

End Sub
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Visual basic statements

In visual basic program (code) there are four basic parts, i.e. it is contains the following
statements:

1- Declaration of variables and constants

2- Inputting variables

3- Operators for variables

4- QOutputting variables

1- Declaration of a variable and constants
The declaration means defining the data type (variable or constant).

- Variables

A variable is a space in memory filled with data (value, character, time

or date).

Notes:

- Variable name must start with character (not number or function) and maximum length 256
character, and does not contain point or symbol.

- Variable name must not repeat for other values.

The variable has to be declared. Variable type is defined by its content .The content may be
data as numeric or character or string or Boolean or date, or any type of data (called variant),
these types declared as:

Dim variable name as type

Or

Global variable name as type

Note: The Dim declaration written in general part of the form or in any place in form or sub
procedure which used for one form. While Global declaration used for all forms

The types of variables that are allowed in visual basic are stated in the table below:

Types of variables
Type Value range Declaration
1-Integer -32768<x<32768 Dim x as integer
2-Long -2.1 e+009<x<2.1 e+009 | Dim x as long
3-Single 1.4e-045 <|x|<3.4e+038 Dim x as single
4-Double 4.9e-324<x<1.79e+308 Dim x as double
5-String 65535 characters Dim x as string
6-Boolean True or false Dim x as Boolean
7-Date Computer time and date Dim x as date

Jan 100<x< 31 Dec 9999







2- Inputting variables
There are methods to input variable x as stated in the following:

Method of input For all type of variable
In text tool X=text,,.text
In mput box X=mputbox("prompt"."title")

Note: To enter many variables we usually use the second method with loop.

3- Operators for variables
The operators that are used for variable are described in the following
table

+ addition

- subtraction
multiplication

/ division

mod Modulus —rest of division
exponent

= equal

Less than

= Less or equal

Arithmetic operators

Relational operators

> Greater than
>= Greater or equal
< Not equal

Note: The order of operations when executing arithmetic operation 1s:
Exponentiation - multiplication division and mod - finally addition and
subtraction.

Assignment statement
There are many statements ways to fill a variable as follows:
Variable = expression

Expression may include variables, operations and functions as follows:
1- Numerical variable. For example: 1=3

2- Mathematical relation. For example: x=a/b

3- Characters variable (string). For example: t="abc¢"

4- Boolean variable (logical). For example: p=true

1



Functions for variables

The numeric and string variables are the most common used variables
in programming, therefore V.B provides the user with many functions to be
used with a variable to perform certain operations or type convention. The
most common functions for numerical variable x

Len(x) Number of character of variable x
Lcase(x) Change the text x to small letters
Ucase(x) Change the text x to capital letters
Cstr(x) Convert variable x to string

Val(x) Convert string X to numerical variable
















Example 5: Write a program to classify any entered number according to
its sign and display the phrase (negative number) when the number 1s
negative and the phrase (positive number) when the number 1s positive,
otherwise display the phrase (neither positive nor negative).

Sol:
Dim x As Single
Private Sub command] click () I
X = Val(Textl.Text) I1

If x > 0 Then [Project] \NNEY
MsgBox "positive number" negelive rumber
ElseIf x < 0 Then
MsgBox "negative number"

Else

MsgBox "neither positive nor negative"
End If

enter nurnber |17
End Sub
(e

negative number

Nested If statement:

It can be takes the following structure: _

If condition then
If condition then
Statements structure?

End if
End if

structure 1

Note: Any structure of if structures can be used insteade of structure 1
and 2 above. & Fornl .. =0

Example 6: Write a program to enter two numbers and -, —
compute multiplication and division operations using - :
option button with display the phrase (illegal division

operation) when the denominator is zero.
Sol:

Dim a, b, ¢ As Single

Private Sub commandl click()

a = Val(Textl.Text)

b = Val(Text2.Text) o
If Optionl.Value Then e
C:a*b ne. 1 |5— nu.E.ID—

Text3. Text = CStr(c)
Else result Im o

























Nested loop:

The nested loops are the loops that are placed inside each other. The most inner
loop will be executed first, then the outer ones. These loops should neither intersect,
nor have the same index. As follows:

Fori=1Ton
Forj=1Tom
Statements
Next |
Next 1
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S-S5 Using ListBox and ComboBox Controls In Visual Basic 6:

The ListBox will display a single column of strings, referred to as items. The items to appear initially
can either be specified at design time with the List property or set with code in the Form Load event
procedure. Then code is used to access, add. or delete items from the list. If the number of items
exceed the value that be displayed. scroll bars will automatically appear on the control. These scroll
bars can be scrolled up and down or left to right through the list.

A ComboBox is best through of as a text box with a help list attached. With an ordinary textbox. the
user must type information into the box. With a combobox, the user has the option of either typing in
information or just selecting the appropriate piece of information from a list. The two most useful
types of combobox are denoted as style property combobox as shown in Figure below.

= Form1 D@E

j |Combo2 | j
style=0 style=1 style=2

With a style 1 combo box., the list is always visible. With style 0 or 2 combobox, the list drops down
when the user clicks on the arrow. In either case. when an item from the list is highlighted. the item
automatically appears in the text box at the top and its value is assigned to the text property of the
combo box. The items to appear initially can either be specified at design time with the combo
property or set with combo_change() event procedure directly.

ComboBoxes have essentially the same properties. event and methods as ListBoxes.

The following Figure lists some of the common ListBox &ComboBox properties and methods.

Property Description
Properties
By setting this property to True or False user can decide whether user
Enabled y setting tis propetty

can interact with this confrol or not

String array. Contains the strings displayed in the drop-down list.

List Starting array index is 0. Use CTRL+Enter to insert values.

Sorted Boolean. Specifies whether the ListBox &ComboBox items are sorted
or not.

Style Integer. Specifies the style of the ListBox &ComboBox appearance

Text String. Specifies the selected item in the ComboBox.

Visible Boolean. Specifies whether ListBox &ComboBox is visible or not at run
time

Event Procedures

Change Called when text in ComboBox is changed

Click Called when the ListBox &ComboBox is clicked






Example 5-10: Design a form with two list boxes, one label, and one command buttons. Write code
for the following-events.
1- Form Load event. to add items (n=100) to listl.
2- In click event of commandl (Sum), to Sum items from list] and add to list2 at each step. Exit
loop if (Sum=120).
3- In click event of list2, to display number of items to labell

Solution:

Private Sub Form Load()
Dim I

ForI=1 To 100

Listl. AddItem Str(I)
Next1

Private Sub Command] _click()

Dim I, Sum

ForI=1 to 100

Sum=Sum-+I or Sum-Sum + list1.list (I-1)
List2. AddItem Str(Sum)

If Sum=120 Then Exit For

Next

End sub



Private Sub List2 Click()
Labell .caption=List2.listcount
End Sub



6- Arrays in Visual Basic 6

An array is a collection of simple variables of the same type to which the computer can efficiently
assign a list of values. Array variables have the same kinds of names as simple variables. An array is a
consecutive group of memory locations that all have the same name and the same type. To refer to a
particular location or element in the array, we specify the array name and the array element position
number. The Individual elements of an array are identified using an index. Arrays have upper and
lower bounds and the elements have to lie within those bounds. Each index number in an array is
allocated individual memory space and therefore users must evade declaring arrays of larger size than
required. We can declare an array of any of the basic data types including variant. user-defined types
and object variables. The individual elements of an array are all of the same data type.

6-1 Declaring arrays: Arrays may be declared as Public (in a code module). module or local.
Module arrays are declared in the general declarations using keyword Dim or Private. Local arrays are
declared in a procedure using Dim. Array must be declared explicitly with keyword "As".
There are two types of arrays in Visual Basic namely:
e 6-1-1 Fixed-Size Array: The size of array always remains the same-size doesn't change
during the program execution. When an upper bound is specified in the declaration, a Fixed-
array is created. The upper limit should always be within the range of long data type.

One Dimension Array:
Declaring a fixed-array, if array-Name is the name of an array variable and N is a whole number, then
the statement

Dim ArrayName (N) As Var Type

Where, the Dim statement is said to dimension the array and (N) is the range of the array. The array
holds either all string values or all numeric values, depending on whether Var Type is string or one of
the numeric type names.

For example:
Dim Num (5) As Integer

In the above illustration, num is the name of the array. and the number 6 included in the parentheses is
the upper limit of the array. The above declaration creates an array with 6 elements, with index
numbers running from 0 to 5.

The numbers inside the parentheses of the individual variables are called subscripts. and each
individual variable is called a subscripted variable or element. The elements of an array are assigned
successive memory locations. The following figure shows the memory location for the array Num(5)

Num (5) Num (0) Num (1) Num (2) Num (3) Num (4) Num (5)

1 3 -10 5 3 2

If we want to specify the lower limit, then the parentheses should include both the lower and upper
limit along with the To kevword. An examole for this is given below.













e 6-1-2 Dynamic Array: The size of the array can be changed at the run time- size changes
during the program execution.

In actual practice. the amount of data that a program will be processing is not known in advance.
Programs should be flexible and incorporate a method for handling varying amounts of data. Visual
basic makes this possible with the statement
ReDim ArrayName (N) As Var Type
This can use variables or expression when indicating the subscript range. However, ReDim statements
can only be used inside procedures.







9- Sub Procedure and Function Procedure

Most computer programs that solve real-world problems are much larger than those presented in the
first few chapters. Experience has shown that the best way to develop and maintain a large program is
fo construct it from smaller pieces each of which is more manageable than the original program. This
technique is called divide and conquer. This chapter describes many key features that facilitate the
design. implementation, operation and maintenance of large programs.

Functions and Subroutines are programs designed for specific task, and could be called from the
main program or from sub-procedures without pre definition or declaration. Users are allowed to call
in any number of times which save the main program space, since it avoids reputation of code these
subroutines could be designed by user or could be previously built. The concepts and descriptions are
summarized in the following table.

Item Subroutine Function
Code Sub Name (arguments) Function Name (arguments)
Statements Statements
End Sub End Function
Remark o Need call statement ¢ Used in arithmetic statement
¢ Return values by arguments ¢ Return value by its name
¢ Return many values (arguments) ¢ Retumn one value
e Used for Input/output. condition |e Used for arithmetic’s or conversion
treatment of variable type.
¢ Could be used with out arguments.
Call Statement | Call Name(valuel,valuel,,.,) Z=name(valuel)
Exit statement | Exit Sub Exit Function

9.1 Sub Procedures

Sub procedure are created with the add procedure dialog (displayed when add procedure is selected
from the tools menu). The add procedure menu item is grayed unless the code window is visible.
Figure (9-1) displays the add procedure dialog. The procedure name is entered in TextBox Name and
can be any valid identifier Frame Type contains option buttons for selecting the procedure type (Sub
or Function). Frame scope contains option buttons for selecting keyword public or keyword private
that will procedure, we will use keyword private, which also preceded our event procedures.

|
_ Goncel |

Type
- Cancel
* Sub [ Property
B BT ¢ Event Figure (9-1): add procedure dialog
Scope
(¢ Public " Private

| All Local variables as Skatics
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1. Steps greate Table using Add-Ins from Menu Bar

File Edit View Project Format Debug Bun Query Diagram Tools | Add-Ins Window Help

al Data Manager...

Add-In Manager...

File | Utility Window
Open DataBase... 4 i | \

| | Mew... 3 | | Microsoft Access 3 Yersion FWDB...
Version 7.0 MDB...

Close Dbase 4

Import/Export... FoxPro 3
Workspace... Paradox »
ODBC...
Errors...
Text Files...
Cormpact MDE... b
Repair MDE...

1 ChUsers\lenovo 1\Documents!library.mdb

2 EMNtelephone.mdb

3 E\Nsalaryl.mdb

4 E\Nsalary.mdb

5 ChUsers\lenovo 1\Documentsisalary.mdb

& C:\Users\lenovo 1\Documents\employ.mdb

7 Chllsers\lenove T\Documents\books.mdb

8 Ch\Users\lenovo 1\Documentsitelephone.mdb

Exit




File Utility Window Help

%IEI@@I@@@ |

Refresh List

o New Table




Table Mame: Table|
Eield List: Mame: |
Type: I— [T FizedlLength
Size: I— [T variableLength
CollatingCrder: I— I autoIncrement
[~ allowZeroLength
OrdinalPosition: I ™ Required
ValidationText: I
—_ ValidationRule: I
Add Field Remove Field | Defaultvalue: |
Index List: Mame: |
I Primary I Unigue [ Foreign
T Reguired I Ignoretull
Add Index Remove Index | Fields: I
Euild the Table | Close |

OrdinalPosibon:

" FixedField
i* VariableField

[T AutolncrField

v aAllowZeroLenath

ValidationText:

ValidationRule:

Defaultvalue:

| e oK I



Mame: OrdinalPosition:
I\'Ear[ I
Type: ValidationText:
ITE}IZt ;I I
Size: ValidationRule:
|s0 |

i~ FixedField

i* VariableField

[T AutolncrField

[v AllowZeroLength

[T Reguired

Defaultvalue:

Table Mame:

Eield List:

ITaI::IEl

Mame: |"|"ear

e ——— [Text [ FixedLenath

Removwve Field Defaultvalue: I

Size: |5|:| ¥ ‘“ariableLenagth
CollatingOrder: I 102 T autalncrement

V¥ AllowZerolLength

OrdinalPosition: IU [~ Reguired

ValidationText: I

ValidationRule: I

Index List: Mame: |
I Primary [T Urique [T Foreign
I Required [T Ignoretull
Ficlds:
Add Index Remove Index | I
’Euild the Table | Close




File Utility Window Help

%IE@@I@@@ |

- Table1

e Ficlds|

|Ready | User: admin p



Manipulating with Records

Add Record

Private Sub Command1_Click()
On Error Resume Next
Adodcl.Recordset.AddNew
End Sub

Delete Record

On Error Resume Next

a = MsgBox("Are you wont to delete this record?", vbYesNo)
If a=vbYes Then

Adodcl.Recordset.Delete

Adodcl.Recordset.MoveNext

End If

End Sub

Update Record

Private Sub Command3_Click)(
On Error Resume Next
Adodcl.Recordset.Update

End Sub

Transfer to the first Record

Private Sub Command4_Click)(
On Error Resume Next

Adodcl.Recordset.MoveFirst



End Sub

Transfer to the last Record

Private Sub Command5_Click)(
On Error Resume Next
Adodcl.Recordset.Movelast
End Sub

Transfer to the next Record

Private Sub Command6_Click)(
On Error Resume Next
Adodcl.Recordset.MoveNext
End Sub

Transfer to the Previous Record

Private Sub Command7_Click)(
On Error Resume Next

Adodcl.Recordset.MovePrevious

End Sub

SQL Statement

Order Ascending

Private Sub Command8_Click()
On Error Resume Next
Adodcl.RecordSource = "select * from Table_Name order by Fileld_Name asc"

Adodcl.CommandType = adCmdText



Adodcl.Refresh
End Sub

Order Descending

Private Sub Command10_Click()
On Error Resume Next

Adodcl.RecordSource = "select * from Table_Name order by Filed_Name desc"
Adodcl.CommandType = adCmdText

Adodcl.Refresh
End Sub

Show Recods

Private Sub Command11_Click()

On Error Resume Next

Adodcl.RecordSource = "select * from Table_Name "
Adodcl.CommandType = adCmdText

Adodcl.Refresh

End Sub

Number Of records

Private Sub Command12_Click()
MsgBox Adodcl.Recordset.RecordCount
End Sub

Maximum Value

Private Sub Command13_Click()

On Error Resume Next



Adodcl.RecordSource = "select * from Table_Name where Filed Name = (select

max (Field_Name) from Table_Name )
Adodcl.CommandType = adCmdText
Adodcl.Refresh

End Sub

Minimum Value

Private Sub Command13_Click()
On Error Resume Next

Adodcl.RecordSource = "select * from Table_Name where Filed Name = (select
min (Field) from Table_Name )"

Adodcl.CommandType = adCmdText
Adodcl.Refresh
End Sub

Research in Database

Private Sub Command15_Click()

On Error Resume Next

Adodc1.RecordSource = "select * from Table_Name where Filed _Name =' Value'"
Adodcl.CommandType = adCmdText

Adodcl.Refresh

End Sub

Research by text

Private Sub Command18_Click()
On Error Resume Next

Adodcl.RecordSource = Text no.Text



Adodcl.CommandType = adCmdText
Adodcl.Refresh

End Sub
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Picture Boxes

e The picture box allows you to place graphics information on a form. It is best
suited for dynamic environments - for example, when doing animation.

e Picture boxes lie in the top layer of the form display. They behave very much like
small forms within a form, possessing most of the same properties as a form.

¢ Picture Box Properties:

AutoSize If True, box adjusts its size to fit the displayed
graphic.

Font Sets the font size, style, and size of any printing done
in the picture box.

Picture Establishes the graphics file to display in the picture
box.

¢ Picture Box Events:

Click Triggered when a picture box is clicked.
DblIClick Triggered when a picture box is double-clicked.

¢ Picture Box Methods:

Cls Clears the picture box.
Print Prints information to the picture box.

¢ Picture Box LoadPicture Procedure:

An important function when using picture boxes is the LoadPicture procedure. It
is used to set the Picture property of a picture box at run-time.

Example
picExample.Picture = LoadPicture("c:\pix\sample.bmp")
This command loads the graphics file c:\pixXisample.bmp into the Picture property

of the picExample picture box. The argument in the LoadPicture function must be
a legal, complete path and file name, else your program will stop with an error

message.



Image Boxes

¢ Animage boxis very similar to a picture box in that it allows you to place
graphics information on a form. Image boxes are more suited for static situations
- that is, cases where no modifications will be done to the displayed graphics.

¢ Image boxes appear in the middle-layer of form display, hence they could be
obscured by picture boxes and other objects. Image box graphics can be resized
by using the Stretch property.

¢ Image Box Properties:

Picture Establishes the graphics file to display in the image
box.
Stretch If False, the image box resizes itself to fit the graphic.

If True, the graphic resizes to fit the control area.
¢ Image Box Events:

Click Triggered when a image box is clicked.
DbIClick Triggered when a image box is double-clicked.

e Theimage box does not support any methods, however it does use the
LoadPicture function. Itis used in exactly the same manner as the picture box
uses it. And image boxes can load the same file types: bitmap (.bmp), icon

(.ico), metafiles (.wmf), GIF files (.gif), and JPEG files (.jpg). With Stretch = True,
all three graphic types will expand to fit the image box area.



Image Boxes

e« An image boxis very similar to a picture box in that it allows you to place
graphics information on a form. Image boxes are more suited for static situations
- that is, cases where no modifications will be done to the displayed graphics.

¢ Image boxes appear in the middle-layer of form display, hence they could be
obscured by picture boxes and other objects. Image box graphics can be resized
by using the Stretch property.

¢ Image Box Properties:

Picture Establishes the graphics file to display in the image
box.
Stretch If False, the image box resizes itself to fit the graphic.

If True, the graphic resizes to fit the control area.
¢ Image Box Events:

Click Triggered when a image box is clicked.
DbIClick Triggered when a image box is double-clicked.

e The image box does not support any methods, however it does use the
LoadPicture function. Itis used in exactly the same manner as the picture box
uses it. And image boxes can load the same file types: bitmap (.bmp), icon

(.ico), metafiles (.wmf), GIF files (.gif), and JPEG files (.jpg). With Stretch = True,
all three graphic types will expand to fit the image box area.



Drive List Box

==

The drive list box control allows a user to select a valid disk drive at run-time. It
displays the available drives in a drop-down combo box. No code is needed to
load a drive list box; Visual Basic does this for us. We use the box to get the
current drive identification.

Drive List Box Properties:

Drive Contains the name of the currently selected drive.
Drive List Box Events:
Change Triggered whenever the user or program changes the

drive selection.

Directory List Box

o

Em

The directory list box displays an ordered, hierarchical list of the user's disk
directories and subdirectories. The directory structure is displayed in a list box.
Like, the drive list box, little coding is needed to use the directory list box - Visual
Basic does most of the work for us.
Directory List Box Properties:

Path Contains the current directory path.

Directory List Box Events:

Change Triggered when the directory selection is changed.



File List Box

o The file list box locates and lists files in the directory specified by its Path

property at run-time. You may select the types of files you want to display in the
file list box.

e File List Box Properties:

FileName Contains the currently selected file name.
Path Contains the current path directory.
Pattern Contains a string that determines which files will be

displayed. It supports the use of * and 7 wildcard
characters. For example, using *.dat only displays
files with the .dat extension.

o File List Box Events:

DbIClick Triggered whenever a file name is double-clicked.
PathChange Triggered whenever the path changes in a file list box.

e You can also use the MultiSelect property of the file list box to allow multiple file
selection.

Example : Photo Browser 1. Design the form
Image



2. Adjust the properties of the form and its objects according to the following table:

Object Property Name Stage of Changing
Filel Pattern *.bmp; *.jpg; *.gif *.ico;
Imagel Stretch True

3. Write the following code :

4. After Run




Common Dialog Boxes

e The primary use for the drive, directory, and file name list boxes is to develop
custom file access routines. Two common file access routines in Windows -based
applications are the Open File and Save File operations. Fortunately, you don'’t
have to build these routines.

e To give the user a standard interface for common operations in Windows-based
applications, Visual Basic provides a set of common dialog boxes, two of
which are the Open and Save As dialog boxes. Such boxes are familiar to any
Windows user and give your application a professional look. And, with Windows

95, some context -sensitive help is available while the box is displayed. Appendix
Il lists many symbolic constants used with common dialog boxes.

¢ The Common Dialog control is a ‘custom control which means we have to
make sure some other files are present to use it. In normal setup configurations,
Visual Basic does this automatically. If the common dialog box does not appear
in the Visual Basic toolbox, you need to add it. This is done by selecting
Components under the Project menu. When the selection box appears, click on
Microsoft Common Dialog Control, then click OK.

¢« The common dialog tool, although it appears on your form, is invisible at run-time.
You cannot control where the common dialog box appears on your screen. The
tool is invoked at run-time using one of five ‘Show’ methods. These methods are:

Method Common Dialog Box
ShowOpen Open dialog box
ShowSave Save As dialog box
ShowColor Color dialog box
ShowfFont Font dialog box
ShowPrinter Printer dialog box

¢ The format for establishing a common dialog box named cdlExample so that an
Open box appears is:

cdlExample.ShowOpen

Control to the program returns to the line immediately following this line, once the
dialog box is closed in some manner. Common dialog boxes are system modal.



To add Common Dialog click object ——» Components ——— Microsoft

Common Dialog Control 6.0 ——— ok

Controls |Des.igners | nsertable Objects |

[ LayoutDTC 1.0 Type Library Py
[ Microsoft ADO Data Control 6.0 (OLEDE)

[ Microsoft Calendar Control 8.0

[ Microsoft Chart Contral 6.0 (OLEDE)

[ Microsoft Comm Control 6.0

Microsoft Commaon Dialog Control 6.0

[ Microsoft Data Bound Grid Control 5.0 (SP3)
[|Microsaft Data Bound List Controls 5.0 ST |
[T Microsoft DataGrid Contral 6.0 (OLEDE)

[ Microsoft Datalist Controls 6.0 (OLEDE)

[ Microsoft DataRepeater Control 6,0 (OLEDE)

[ Microsoft OTC Framework

[ Microsoft FlexGrid Control 6.0 W Browse... |
£ >

[T Selected Items Only

—Adobe Acrobat 7.0 Browser Control Type Library 1.0
Location: C:\...\Acrobat\ActiveX\AcroPDF.dll

1. Open Dialog box : A box (Open) is used to open a specific file within the computer.
We use the following formula to open a box :
CommonDialog1.ShowOpen
The box shown below appears. The file name chosen can be obtained through a
property ( FileName )



2. Save Dialog box : We use the following formula to save a box :
CommonDialogl.ShowSave
The box shown below appears :

3. Font Dialog box : We use the following formula to font a box :
CommonDialogl.ShowFont
The box shown below appears :



4. Color Dialog Box: allows the user to choose a color for a specific purpose, such as
changing the background color of the program or changing the background color of an
existing control Within the program . We use the following formula to font a box :
CommonDialog1.ShowColor
The box shown below appears :

I

Basic colors:
_AmEnl dml 0 0
HMrFEFEEN
ENENEEEEN
ENEEEEEn
AN EEEEEN
HE NN .
Custom colars:
FECrEE NN
AEEEEEEENn
Define Custom Calors == |
oK | Cancel |

Example : 1. Design Form with one CommonDialogl, textbox and 5 commonds , The
design shown below appears :




2. Write the code listed below:
1. Open Dialog box
Private Sub Commandl1_Click()

" CancelError is True.
On Error GoTo ErrHandler
' Set filters.
CommonDialogl.Filter = "All Files (*.*)[*.*|Text _ Files (*.txt)|*.txt"
' Specify default filter.
CommonDialogl.FilterIndex = 2
intfile = FreeFile
CommonDialogl.InitDir = "c:\"
CommonDialogl.DefaultExt = ".txt"
' Display the Open dialog box.
CommonDialogl.ShowOpen
Open CommonDialogl.FileName For Input As #intfile
Textl.Text = Input$(LOF(intfile), intfile)
Close #intfile
ErrHandler:
" User pressed Cancel button.
Exit Sub
End Sub

2. Save Dialog box
Private Sub Command2_Click()
" CancelError is True.
On Error GoTo ErrHandler
' Set filters.
CommonDialogl.Filter = "All Files (*.*)[*.*|Text _ Files (*.txt)[*.txt"
' Specify default filter.
CommonDialogl.Filterindex = 2
' Display the Open dialog box.
CommonDialogl.ShowSave
If CommonDialogl.FileName <>"" Then
apppath = CommonDialogl.FileName
valtext = Textl.Text



Open apppath For Append As #1

Print #1, valtext

Close #1

End If

ErrHandler:

" User pressed Cancel button.
Exit Sub

End Sub

3. Font Dialog box

Private Sub Command3_Click()

' Set Cancel to True.
CommonDialogl.CancelError = True
On Error GoTo ErrHandler
' Set the Flags property.
CommonDialogl.Flags = cdlCFBoth Or cdICFEffects
' Display the Font dialog box.
CommonDialogl.ShowFont
' Set text properties according to user's
' selections.
Textl.Font.Name = CommonDialogl.FontName
Textl.Font.Size = CommonDialogl.FontSize
Textl.Font.Bold = CommonDialogl.FontBold
Textl.Font.ltalic = CommonDialogl.Fontltalic
Textl.Font.Underline = CommonDialogl.FontUnderline
Textl.ForeColor = CommonDialogl.Color
Exit Sub

ErrHandler:
" User pressed Cancel button.
Exit Sub

End Sub

4.Color Dialog box

Private Sub Command4_Click()
' Set Cancel to True.



CommonDialogl.CancelError = True
On Error GoTo ErrHandler
* Set the Flags property.
CommonDialogl.Flags = cdICCRGBInit
' Display the Color dialog box.
CommonDialogl.ShowColor
' Set the form's background color to the selected
' color.
Forml.BackColor = CommonDialogl.Color
Exit Sub

ErrHandler:
" User pressed Cancel button.
Exit Sub

End Sub

5. Print Dialog box

Private Sub Command5_Click()

Dim BeginPage, EndPage, NumCopies, Orientation, i
' Set Cancel to True.
CommonDialogl.CancelError = True
On Error GoTo ErrHandler
' Display the Print dialog box.
CommonDialogl.ShowPrinter
' Get user-selected values from the dialog box.
BeginPage = CommonDialogl.FromPage
EndPage = CommonDialogl.ToPage
NumCopies = CommonDialogl.Copies
Orientation = CommonDialogl.Orientation
Fori=1To NumCopies
' Put code here to send data to your printer.
Next
Exit Sub

ErrHandler:
" User pressed Cancel button.
Exit Sub

End Sub



Horizontal and Vertical Scroll Bars

4 =

Horizontal and vertical scroll bars are widely used in Windows applications.
Scroll bars provide an intuitive way to move through a list of information and make
great input devices.

Both type of scroll bars are comprised of three areas that can be clicked, or
dragged, to change the scroll bar value. Those areas are:

End amow ——H| a
AN

Scroll box (thumb Bar area

Clicking an end arrow increments the scroll box a small amount, clicking the
bar area increments the scroll box a large amount, and dragging the scroll box
(thumb) provides continuous motion. Using the properties of scroll bars, we can
completely specify how one works. The scroll box position is the only output
information from a scroll bar.

Scroll Bar Properties:

LargeChange Increment added to or subtracted from the scroll bar
Value property when the bar area is clicked.

Max The value of the horizontal scroll bar at the far right
and the value of the vertical scroll bar at the bottom.
Can range from-32,768 to 32,767.

Min The other extreme value - the horizontal scroll bar at
the left and the vertical scroll bar at the top. Can
range from-32,768 to 32,767.

SmallChange The increment added to or subtracted from the scroll
bar Value property when either of the scroll arrows is
clicked.

Value The current position of the scroll box (thumb) within
the scroll bar. If you set this in code, Visual Basic
moves the scroll box to the proper position.



Scroll Bar Events:

Change Event is triggered after the scroll box's position has
been modified. Use this event to retrieve the Value
property after any changes in the scroll bar.

Scroll Event triggered continuously whenever the scroll box
Is being moved.



Example :
Temperature Conversion

Start a new project. In this project, we convert temperatures in degrees Fahrenheit
(set using a scroll bar) to degrees Celsius. As mentioned in the Review and
Preview section, you should try to build this application with minimal reference to the
notes. To that end, let's look at the project specifications.






Label1:
Alignment
Caption
FontSize
FontStyle

Label2:
Alignment

AutoSize
BackColor
BorderStyle
Caption
FontSize
FontStyle
Name

Label3:
Alighnment
Caption
FontSize
FontStyle

Label4:

Alignment
AutoSize

BackColor
BorderStyle
Caption
FontSize
FontStyle
Name

Command1:
Cancel
Caption
Name

2-Center
Fahrenheit
10

Bold

2-Center

True

White

1-Fixed Single
32

14

Bold

IblITempF

2-Center
Celsius
10

Bold

2-Center

True

White

1-Fixed Single
0

14

Bold

IblTempC

True
E&xit

cmdExit

Note the temperatures are initialized at 32F and 0C, known values.






Put this code in the general declarations of your code window.

Option Explicit
Dim TempF As Integer
Dim TempC As Integer

This makes the two temperature variables global.

Attach the following code to the scroll bar Scroll event.

Private Sub vstemp_Scroll{)

'Read F and convert to C

TempF = vsbTemp.Value

1blTempF .Caption = Str (TempF)
TempC = CInt((TempF - 32) * 5 / 9)
1blTempC.Caption = Str (TempC)

End Sub

This code determines the scroll bar Value as it scrolls, takes that value as
Fahrenheit temperature, computes Celsius temperature, and displays both
values.
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7- Graphics in Visual Basic

7.1 Introduction: Graphics are the elements of a picture. Colors, lines, rectangles, patterns, text, etc.
are all graphics. Graphics are visual. Visual Basic provides graphics capabilities for drawing shapes in
different colors and patterns. Visual basic is also capable of displaying many popular image formats.
Although the graphics capabilities may not be as feature rich as graphics software programs. visual
basic’s graphic capabilities are integral to creating polished windows applications.

7.2 Coordinate Systems: To draw in visual basic, we must understand Visual Basic’s coordinate
system as shown in figure below. that identifies points on the screen (such as forms or pictureboxes).
By default, the upper-left point on the screen has coordinate (0.0), which is commonly called the
origin. A coordinate pair is composed of an x ceordinate (the horizontal coordinate) and y coordinate
(the vertical coordinate). The x coordinate is the horizontal distance on the x axis from the origin. The
v coordinate is the vertical distance on the y axis from the origin. The unit that a coordinate system is

measured in is called a scale. Visual basic provides eight coordinate system scales. Most controls as

well as the form use twips by default. Property ScaleMode specifies the scale.

+X
(X1,Y1) @ » X axis

+Y (X2,Y2)

v
Y axis

User-defined coordinates are fdefined using method scale. Two set of coordinates define the scale.
The first coordinate set defines the upper-left corner and the second coordinate set defines the lower-
right corner. The statement,

Scale (xx1,yyl)-(xx2,yy2)

For example:

o Scale(0,0)-(100,100)
e Scale (100,100)-(0,0)
e Scale(-100,100)-(100.-100)

7.2 Graphics Method:
Visual basic provides several methods for creating graphics. The graphics methods. summarized in the
following table. apply to forms.




Method Description

Line Draws lines on a form. Can also be used to draw rectangles.
Circle Draws circles on a form. Can also be used to draw ellipses
Pset Sets a point’s color

Print Draw text on a form.

++ Method Line: draws lines and rectangles between two sets of coordinates. The first set of
coordinates is the starting point and the second is the ending point.

Line (x1,y1)-(x2,y2),color

For example:
Line (0,0)-(100,100).VbBlue
Line(100,50)-(50.50),QbColor(5)

Line(50,50)-(50,100).RGB(45,100,10)

For rectangles (also called boxes) the first coordinate set specifies the upper-left corner and the
second specifies the lower-right corner.

Line (x1,y1)-(x2,y2),color, B

[or BF]

The visual basic constant (Vb) which represents the color name,. the third argument (B). indicates that
the method should draw a rectangle. A third argument of (BF) would indicate that the rectangleshould
be filled (solid). For example

e Line (0,0)-(55.21), ,B [
e Line(25.50)-(75,100), ,Bf [N

» Note: There are three ways to specify a color value at run time.
1- Use RGB(1To 255. 1To 255.1 To 255) function
2- Use the QBColor(1 to 15) function to choose one of 15 Microsoft QuickBasic color as shown

in table below

3- Enter a color value directly (VbColor) as shown in table below.

Vb Code Color Constant Vb Code Color Constant
0 Black vbBlack 8 Grey vbGrey
1 Blue vbBlue 9 Light Blue vbLightBlue
2 Green vbGreen 10 Light Green vbLightGreen
3 Cyan vbCyan 11 Light Cyan vbLightCyan
4 Red vbRed 2 Light Red vbLightRed
5 Magenta vbMagenta 13 Light Magenta vbLightMagenta
6 Brown vbBrown 14 Yellow vbYellow
7 White vbWhite 15 Bright White vbBrightWhite
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